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Featured launch: Security center for G Suite  
Security analytics and best practices from Google 

  Announced January 17th, 2018     Admin feature                                                       - ​back to top​ - 

What’s new​: We want to make it easy for you to manage your organization’s data security. A big part of this is 
making sure you and your admins can access a bird’s eye view of your security—and, more importantly, that 
you can take action based on timely insights. 
 
With this launch, we introduced the security center for G Suite, a tool that brings together security analytics, 
actionable insights and best practice recommendations from Google to empower you to protect your 
organization, data and users. 
 

 
 
With the security center, key executives and admins can do things like: 
 
1. See a snapshot of important security metrics in one place.​ Get insights into suspicious device activity, 
visibility into how spam and malware are targeting users within your organization and metrics to demonstrate 
security effectiveness—all in a unified dashboard. 

 
 
2. Stay ahead of potential threats. ​Admins can now examine security analytics to flag threats. For example, 
your team can have visibility into which users are being targeted by phishing so that you can head off 
potential attacks, or when Google Drive files trigger DLP rules, you have a heads up to avoid risking data 
exfiltration. 
 

2 



 
 
3. Reduce risk by adopting security health recommendations. ​Security health​ analyzes your existing security 
posture and gives you customized advice to secure your users and data. These recommendations cover 
issues ranging from how your data is stored, to how your files are shared, as well as recommendations on 
mobility and communications settings. 
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https://support.google.com/a/answer/7491656?hl=en&ref_topic=7492190&utm_source=gsuite-updates&utm_medium=blog&utm_campaign=securitycenterga


Get started 
More than 3.5 million organizations rely on G Suite to collaborate securely. If you’re a ​G Suite Enterprise 
customer, you can now access the ​security center​ within the Admin console. ​These instructions​ can help 
admins get started and ​here​ are some security best practices to keep in mind. 
 
If you’re new to G Suite, ​learn more​ about about how you can collaborate, store and communicate securely.  
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https://gsuite.google.com/pricing.html?utm_source=gsuite-updates&utm_medium=blog&utm_campaign=securitycenterga&tab_activeEl=tabset-companies
https://gsuite.google.com/products/admin/security-center/?utm_source=gsuite-updates&utm_medium=blog&utm_campaign=securitycenterga
https://support.google.com/a/answer/7486127
https://support.google.com/a/answer/7587183?utm_source=gsuite-updates&utm_medium=blog&utm_campaign=securitycenterga
https://gsuite.google.com/security/?utm_source=gsuite-updates&utm_medium=blog&utm_campaign=securitycenterga


 

 

Work together 

Improved accessibility for Google Sheets, Slides, and Drawings 

  Announced on January 9th, 2018     Share with your organization                       - ​back to top​ - 

 
What’s new:​ We want to make sure our products work well for everyone. That’s why, as part of our ongoing 
accessibility initiatives, we’ve launched new features for Google Sheets, Slides, and Drawings. Specifically, 
we’ve added Braille support in Google Sheets, and screen magnifier support in Google Slides and Drawings. 
 
Use Google Sheets with Braille displays 
You can already use Braille displays to read and edit text in Docs, Slides and Drawings. Now we’ve added 
Braille support to Sheets as well. You can use a Braille display to read and edit cell contents as well as 
navigate between cells in a sheet. At the moment, Braille support in Sheets is only available on Chrome OS 
with the ChromeVox screen reader. We’re working to add support for other platforms and screen readers. 
 
See our Help Center to find out ​how to use a Braille display with Sheets​. 
 
Use screen magnifiers with Google Slides and Drawings 
We recently added screen magnifier support to Docs and Sheets. Now screen magnifiers also work with 
Slides and Drawings. 
 
You can use screen magnifiers with Docs, Sheets, Slides, and Drawings on Mac and Chrome OS devices.  
 
See our Help Center to learn ​how to use screen magnifiers with Google Docs editors​.  
 
 

Dial into Hangouts Meet from nine additional markets 

  Announced on January 11th, 2018     Share with your organization                       - ​back to top​ - 

 
What’s new:​ In October 2017, ​we announced​ the rollout of international Hangouts Meet 
dial-in phone numbers for G Suite Enterprise domains. This option helps your team to stay 
connected, wherever they are. We’ve added this functionality for nine additional countries: 
Austria, Belgium, Czech Republic, Finland, Ireland, Norway, Romania, Switzerland and 
Turkey. 
 
The current list of included countries (with more to come!) is: 

● Australia (AU) 
● Austria (AT) 
● Belgium (BE) 
● Brazil (BR) 
● Canada (CA) 
● Czech Republic (CZ) 
● Denmark (DK) 
● Finland (FI) 
● France (FR) 
● Germany (DE) 
● Ireland (IE) 
● Italy (IT) 

● Netherlands (NL) 
● New Zealand (NZ) 
● Norway (NO) 
● Poland (PL) 
● Romania (RO) 
● South Africa (ZA) 
● Spain (ES) 
● Sweden (SE) 
● Switzerland (CH) 
● Turkey (TR) 
● United Kingdom (GB) 
● United States (US) 

Check out the ​Help Center​ for more information on joining a video meeting. 
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https://support.google.com/docs/answer/6057417?co=GENIE.Platform%3DDesktop
https://support.google.com/docs/answer/6282736?co=GENIE.Platform%3DDesktop
https://gsuiteupdates.googleblog.com/2017/10/international-phone-number-meet.html
https://support.google.com/meet/answer/7308559


 View your Slack activity from within Google Drive 

  Announced on January 31st, 2018     Share with your organization                       - ​back to top​ - 

 
What’s new:​ Never miss an important update, on either Slack or Google Drive. We’ve added activity events to 
allow you to see, in Drive, when a file is shared or discussed from within Slack. Two types of actions are 
logged as events: someone sharing a file stored in Google Drive, and someone commenting—within Slack—on 
a Google Drive file that has been shared in Slack. 
 
In these events, you will see information about when the action occurred, who did it, and where it happened. 
The events in the activity logs are private to only those who have access to both the document, as well as the 
Slack channel or team where the document was shared or discussed. 
 

 
 
This launch follows the ​previously announced​ Drive integration with Slack, where we added the ability to see 
notifications in Slack of activity happening in Google Drive. In order to take advantage of this feature, ​install 
the Google Drive integration​. 
 
Whether you’re trying to stay on top of Slack discussions, know what’s being collaborated on, or a new team 
member catching up on prior discussions, these event logs help you keep track of what’s happening to your 
files in both locations. 
 
We’re also launching international language support for our Google Drive integration. If you use Slack in 
French, Spanish, German or Japanese, the Google Drive bot will send messages and respond to you in your 
preferred language. 
 
Check out the ​Help Center​ for information on how to see Google Drive activity in Slack. 
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https://gsuiteupdates.googleblog.com/2016/10/five-new-ways-to-reach-your-goals.html
https://slack.com/services/B75U3LCNT
https://slack.com/services/B75U3LCNT
https://support.google.com/drive/answer/7570232


 

 

Simple to use  
New Google Calendar web UI now default option for those on automatic rollout 

  Announced on January 3rd, 2018     Share with your organization                       - ​back to top​ - 

 
What’s new:​ In October 2017, we ​announced​ a new user interface (UI) for Google Calendar 
on the web. As a reminder, admins have several ​options​ for how their users will transition 
to this new UI. 
 
As of January 15th, we’ve auto-upgraded all users whose domains are set to the 
automatic (default) rollout option. 
 
In this phase, users will still have the option to opt out of the new UI until ​February 28th, 2018​, when all users 
will be fully upgraded. 
 
Please note, any individual users who had manually opted out of the new web UI previously will not be 
upgraded until February 5th. 
 
Additionally, while this opt-out phase does not impact domains whose admins have selected a manual rollout, 
users in these domains will still be upgraded to the new UI on February 28th, 2018, with no option to opt out.  
 
More Information 
Help Center: Control access to the new Calendar​ (admin-facing) 
Help Center: Learn what's new in Google Calendar​ (user-facing) 
 

 

Search within a folder in Google Drive 

  Announced on January 9th, 2018     Share with your organization                       - ​back to top​ - 

 
What’s new:​ You can now search for content in a specific folder in Google Drive. Select the drop-down in the 
search bar and choose the folder you want from the Location menu, or right-click on a folder and search 
within that folder. Only folders that are within your My Drive or within Team Drives can be searched; if you 
have a folder that is shared with you, first add the folder to your My Drive. 
 

 
 
Learn more about finding files in Drive in the ​Help Center​. 
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https://gsuiteupdates.googleblog.com/2017/10/new-calendar-user-interface17.html
https://support.google.com/a/answer/7534764
https://support.google.com/a/answer/7534764
https://support.google.com/calendar/answer/7541906
https://support.google.com/drive/answer/2375114


 

 

More menu improvements in Google Docs and Slides 

  Announced on January 18th, 2018     Share with your organization                       - ​back to top​ - 

 
What’s new:​ Based on usage data and your feedback, we’ve made some changes to the menus and toolbars 
in Google Docs and Slides on the web. These are similar to some ​previous changes​ we made and will make it 
easier to find certain items. Among other things, these changes include: 
 
To add a line or page break in Docs: 

● Before: Insert > Page break or Column break 
● After: Insert > Break > Page break or Column break 
● See Help Center for more details: ​Add, edit, or remove a link, bookmark, or page break​. 

To add Alt text to a shape in Docs or Slides: 

● Before: Select shape > Format > Alt text. This option will be removed from the menu. 
● After: Right click on shape > Alt text. This is the new way to add alt text to a shape. 
● See Help Center for more details: ​Make your document or presentation accessible​. 

To change a shape in Slides: 

● Before: Select shape > Format > Change shape. This option will be removed from the menu. 
● After: Right click on shape > Change shape. This is the new way to change a shape. 

The HTML view in Slides is being removed from the menu. 

● Before: View > HTML 
● After: Ctrl+Alt+Shift+P 
● See Help Center for more details: ​Make your document or presentation accessible​. 

These changes will only affect the visual menu. All options will still be available via ​keyboard shortcuts​ and 
the search box in the Help menu.  

 

Publish sites to a specific audience in the new Google Sites 

  Announced on January 29th, 2018     Share with your organization                       - ​back to top​ - 

 
What’s new:​ Some sites aren’t for everyone. That’s why we’ve made it possible to specify exactly who can 
view your content in the new Google Sites. 
 

To publish your site to a specific audience, select the “Share with others” icon and change the Published 
settings to “Specific people can view when published.” Next, add the individuals you want in the “Invite 
people” box and select “Can view published.” 
 

 
 

This feature is available now on the web; it will roll out in the Google Drive Android and iOS apps over the 
coming weeks. ​For more info on publishing in the new Google Sites, visit the ​Help Center. 
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https://gsuiteupdates.googleblog.com/2017/12/improving-menus-and-toolbars-in-docs-and-slides.html
https://support.google.com/docs/answer/45893
https://support.google.com/docs/answer/6199477
https://support.google.com/docs/answer/6199477
https://support.google.com/docs/answer/179738
https://support.google.com/sites/answer/6372880


 

 

Business ready 
Install Gmail Add-ons for your entire domain 

  Announced on January 8th, 2018     Admin and developer feature                                  - ​back to top​ - 

 
What’s new​: We ​recently launched​ Gmail Add-ons, which allow you to work with your ​favorite business 
apps​—directly from Gmail. To make it super easy for users to access these helpful tools, we’ve now made it 
possible for G Suite admins to install Gmail Add-ons for their entire domains. To install an Add-on, click the 
Settings gear icon in Gmail and select “Get add-ons.” For additional info, see the ​Help Center​. 
 

 
 
In addition, we’re making it easier for developers to design Gmail Add-ons specifically for their organizations. 
Developers in your domain will notice two changes: 

● They’ll be able to ​install Gmail Add-ons for their own G Suite accounts ​before​ they’re published​, to aid 
in the development process. Previously, this was limited to their personal Gmail accounts. 

● They’ll be able to publish Gmail Add-ons to users in their own G Suite domains. In addition, they'll be 
able to publish to the general public, after requesting and receiving publication permission. 

Stay tuned to the ​G Suite Developers Blog​ to learn more about these two developer capabilities. 
 
These new features make it easier for users to take advantage of Gmail Add-ons and breeze through their 
email-related action items—without ever leaving Gmail. 
 
More Information 
G Suite Marketplace: Gmail Add-ons 
Help Center: Install Marketplace apps 
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https://gsuiteupdates.googleblog.com/2017/10/do-more-your-inbox-gmail-add-ons.html
https://gsuite.google.com/marketplace/category/works-with-gmail
https://gsuite.google.com/marketplace/category/works-with-gmail
https://support.google.com/a/answer/172482
https://developers.google.com/gmail/add-ons/how-tos/install-unpublished
https://developers.google.com/gmail/add-ons/how-tos/install-unpublished
https://developers.google.com/gmail/add-ons/how-tos/install-unpublished
https://gsuite-developers.googleblog.com/2018/01/publish-gmail-add-ons-to-your-domain.html
https://gsuite.google.com/marketplace/category/works-with-gmail
https://support.google.com/a/answer/172482


 

 

Delegate additional Gmail privileges to users 

  Announced on January 8th, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: Managing the secure and efficient flow of email is critical to any organization’s success, but it 
can be a massive undertaking for a G Suite admin. To make this effort a bit easier, we’re introducing three 
new Gmail privileges that G Suite super admins can grant to other users—without needing to give them super 
admin status: (1) Email Log Search, (2) Access Admin Quarantine, and (3) Access Restricted Quarantines. 
 

 
 
Email Log Search 
This privilege grants a user access to Gmail’s ​Email Log Search​ feature, which makes it easy to track 
message delivery, view the impact of certain policies on email flow, and identify the IP addresses of 
connecting servers. 
 
Access Admin Quarantine 
G Suite admins ​can configure policies and settings to quarantine certain email messages​, helping to prevent 
spam, minimize data loss, and protect confidential information. This privilege gives a user access to the 
Admin Quarantine​, where they can allow or prohibit those messages from being delivered. Note that this 
privilege won’t allow a user to view or change any Admin Quarantine settings. 
 
Access Restricted Quarantines 
This privilege also gives a user access to the Admin Quarantine, but only to those quarantines for which 
they’re part of the quarantine reviewers group. Note that this privilege, like the one above, won’t allow a user 
to access any Admin Quarantine settings. 
 
Super administrators can ​delegate these privileges​ to users by clicking CREATE A NEW ROLE in the Admin 
roles section of the Admin console and then selecting Services > Gmail and the specific privilege from the 
Privileges menu. 
 
More Information 
Help Center: About Email Log Search 
Help Center: Set up and manage admin quarantines 
Help Center: Create custom administrator roles 
 

New navigation menu for Admin console 

  Announced on January 16th, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: We’ve launched a new side navigation menu which will make it easier to see, find, and directly 
navigate to the information and settings in your Admin console. This change has several advantages, 
including: 
 
Easily scan more logical menu options  
We’ve grouped menu options based on how our customers use them to create a logical multi-layered menu. 
This makes the menu shorter and more scannable, helping you find things quickly. 
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https://support.google.com/a/answer/2604578
https://support.google.com/a/answer/6104172
https://email-quarantine.google.com/adminreview
https://support.google.com/a/answer/2406043
https://support.google.com/a/answer/2604578
https://support.google.com/a/answer/6104172
https://support.google.com/a/answer/2406043


 
 
Quickly find what you’re looking for  
You can hover and click through the menu to drill down directly to the pages you want to see—so you’ll spend 
less time browsing, and more time doing. 
 

 
 
Streamlined menu removes clutter for delegated admins  
Delegated admins now only see the menu items they have access to with their level of administrative 
privileges. This makes their menu streamlined and simpler to use. 
 
To learn more about the Admin console and how to use it, ​visit the Help Center​. 
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https://support.google.com/a/#topic=7570177


 

 

Hangouts Meet metrics in Reports API; tablet support now available 

  Announced on January 22nd, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: Hangouts Meet helps you connect with your team from anywhere with easy-to-join video calls. 
We’ve introduced new features to help you and your teams maximize how they collaborate. 
 
Hangouts Meet metrics added to G Suite Reports API 
To help you better understand Hangouts Meet usage within your domain, we’re introducing ​more than 50 new 
metrics​ in the ​Reports API Customer Usage report​. These new metrics provide details on the duration, size, 
and device-specific characteristics of the Meet calls across your organization. 
 
This will give you insights on how to improve your organization’s collaboration and productivity with Meet. 
You can learn more about the new metrics and how you can use them ​here​. 
 
All Hangouts-related metrics that were previously provided under the Google+ metrics group have been 
migrated to a newly introduced metrics group called Meet. You can learn more about the migration to the new 
Meet metrics ​here​. 
 
Hangouts Meet supported on tablets 
You can now use Hangouts Meet on your Android and iOS tablets. This will help your team members join 
meetings from any of their devices. 
 

 
 
More Information 
Reports API: Customer Usage Metrics 
Reports API: Customer Usage – Google Hangouts Meet Metrics 
Reports API: Customer Usage - Google Hangouts Meet Metrics Migration Guide 
Help Center: Download the Meet mobile app 

 

Upcoming change to setup flow for company-owned Android devices 

  Announced on January 22nd, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: As a G Suite admin, you can use ​Google Mobile Management​ to manage, secure, and monitor 
mobile devices in your organization. Additionally, if you provide your employees with devices, you can apply 
policies that regulate app installation, network settings, security options, and more. 
 

If you have ​Advanced management​ enabled, you can ​set up Android devices* your company owns​ in one of 
two ways. (1) You can add devices in the Admin console, automatically assigning their ownership to your 
organization, or (2) you can allow individual users to assign ownership of their devices to your organization 
when they set them up. ​If you choose the second option, those users will see changes to their setup flow 
starting on February 12th, 2018.​ (*These devices must be running Android 6.0 or higher.) 
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https://developers.google.com/admin-sdk/reports/v1/reference/usage-ref-appendix-a/customers-meet
https://developers.google.com/admin-sdk/reports/v1/reference/usage-ref-appendix-a/customers-meet
https://developers.google.com/admin-sdk/reports/v1/reference/usage-ref-appendix-a/customers
https://developers.google.com/admin-sdk/reports/v1/reference/usage-ref-appendix-a/customers-meet
https://developers.google.com/admin-sdk/reports/v1/updated-meet-metrics
https://developers.google.com/admin-sdk/reports/v1/reference/usage-ref-appendix-a/customers
https://developers.google.com/admin-sdk/reports/v1/reference/usage-ref-appendix-a/customers-meet
https://developers.google.com/admin-sdk/reports/v1/updated-meet-metrics
https://support.google.com/meet/answer/7291339
https://support.google.com/a/answer/7396025
https://support.google.com/a/answer/6328699
https://support.google.com/a/answer/7129612


Currently, when a user with a brand new Android device (or one that’s recently been factory reset) adds their G 
Suite account to that device ​before​ adding their personal account, they have to check a box to assign device 
ownership to their organization. (If they add their personal account ​first​, then they’re prompted to set up a 
work profile when they add their G Suite account later on.) We’ve learned that some users skip checking the 
box to assign device ownership, even if their phone is company-owned, resulting in a fragmented 
management experience. 
 

 
Current setup screen 

 

To encourage more users to make the correct selection, we’re changing the language and option on this 
screen. Starting on February 12th, 2018, users will be asked if they own the device they’re setting up. Unless 
they explicitly state that they own the device personally, ownership will be auto-assigned to your organization. 
Again, this will only occur when a user adds their G Suite account to a device before adding their personal 
account. 
 

 
New setup screen 

 
We hope this will result in fewer company-owned devices that are incorrectly set up and an improved mobile 
management experience. 
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Jamboard now a core G Suite service 

  Announced on January 24th, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: Last year, we ​introduced​ ​Jamboard​, a collaborative digital whiteboard device 
with accompanying mobile and web applications, designed to take creativity and 
collaboration to the next level. 
 
Under the hood, the Jamboard ​service​ allows G Suite admins to manage their Jamboard 
devices, and enables G Suite users to interact with jam content on their ​phone​, ​tablet​, or 
on the ​web​. Jamboard combines the same collaborative benefits of real-time co-editing as other G Suite 
applications like Google Docs with a blank canvas that allows ideas and projects to come to life. We’re 
excited to announce that starting today, the Jamboard service will become a core G Suite service. 
 
What this means: 

1. The Jamboard service is now covered under your existing G Suite agreement and offers the same 
technical support and service level commitments as any ​other core service​. 

2. The Jamboard service will be removed from the list of ​Additional Google Services​ and added to the list 
of core G Suite services in your Admin console. 

Note that the Jamboard service is launching ​default ON​, but will respect your ​setting​ for opting in to new 
services. 
 
To learn more about how a Jamboard device (currently available in the US, UK, and Canada, with more countries 
coming soon) can pair with the Jamboard service for the best possible team collaboration and creativity 
experience, visit the ​Jamboard website​. 
 
 

Improved attachment compliance in Gmail 

  Announced on January 24th, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: As a G Suite administrator, one of your most important jobs is to keep your organization’s data 
from falling into the wrong hands. ​Gmail Data Loss Prevention (DLP)​ helps you do just that, by allowing you to 
scan and systematically take action on your users’ inbound and outbound email traffic. With this launch, we’re 
improving that capability, specifically in the area of ​attachment compliance​. 
 
Previously, when you specified a custom* file type to search for in Gmail attachments, we only scanned the 
message’s MIME header for the attachment’s filename extension. This meant that if a sender renamed their 
attachment’s extension, it might not be flagged. Now, if you check the “Also match files based on file format 
(supported types)” box, we’ll also scan the ​contents​ of the attachment to determine its file type (provide it’s 
one of several ​supported types​). 
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https://gsuiteupdates.googleblog.com/2017/05/lets-jamjamboard-is-now-available.html
https://gsuite.google.com/products/jamboard/
https://support.google.com/jamboard/answer/7424836
https://support.google.com/jamboard/answer/7384354
https://support.google.com/jamboard/answer/7384355
https://support.google.com/jamboard/answer/7384356
https://www.google.com/apps/intl/en/terms/user_features.html
https://support.google.com/a/answer/181865
https://support.google.com/a/answer/82691
https://gsuite.google.com/products/jamboard/?utm_source=gsuite-updates&utm_medium=blog&utm_campaign=jamboard-core-service
https://support.google.com/a/answer/6280516
https://support.google.com/a/answer/2364580
https://support.google.com/a/answer/2364580


 

 
 
This will improve attachment compliance and further prevent data loss in your organization. To learn more 
about setting up rules for attachment compliance, check out the ​Help Center​. 
 
*Note that this launch only applies to searches for custom file types; we already scan the content of an 
attachment to detect other file types (like Office documents, videos, and images). 

 

Twenty-two third-party applications added to the G Suite pre-integrated SAML 
apps catalog 

  Announced on January 29th, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: With ​Single-Sign-On (SSO)​, users can access all of their enterprise cloud applications—including 
the Admin console for admins—after signing in just one time. Google supports the two most popular 
enterprise SSO standards, OpenID Connect and SAML, and there are more than 800 applications with 
pre-integrated SSO support in our third-party apps catalog already. 
 
We’ve now added SAML integration for 22 additional applications: ​7geese, Accellion, Bime, Bugsnag, Canvas 
LMS, Honey, Humanity, Jitbit, Kintone, Knowbe4, Kudos, Looker, Meraki, Mingle, RemedyForce, Replicon, 
Rollbar, Signal FX, StatusPage, Weekdone, Wrike, and Zoho CRM.  
 
You can find our full list of pre-integrated applications, as well as instructions for installing them, in the ​Help 
Center​. 
 
Note that apart from the pre-integrated SAML applications, G Suite also supports installing “Custom SAML 
Applications,” which means that admins can install any third-party application that supports SAML. The 
advantage of a pre-integrated app is that the installation is much easier.  
 
You can learn more about installing Custom SAML Applications in this ​Help Center article​. 
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https://support.google.com/a/answer/2364580
https://support.google.com/a/answer/60224
https://support.google.com/a/topic/6194927
https://support.google.com/a/topic/6194927
https://support.google.com/a/answer/6087519


 

 

Publish private apps to multiple organizations 

  Announced on January 31st, 2018                        Share with your organization                                                  - ​back to top​ - 

 
What’s new​: Businesses using ​Google Mobile Management​ and other Enterprise Mobility Management (EMM) 
providers can publish Android apps customized for their workplace directly to their managed Google Play 
store, where their employees can easily access and install them. In some cases, these customers have set up 
multiple “organizations” within their domain (e.g. to serve different regions, for testing purposes, etc.), each of 
which needs access to the custom app. To meet this need, we made it possible to publish a single private app 
to up to 20 organizations. This has several advantages: 
 

1. Developers can publish apps to domains other than their own (including developers with personal 
@gmail.com accounts). 

2. Developers no longer need to be admins of the organizations they’re publishing to. 
3. Businesses can more easily delegate app publishing to third-party developers. 
4. Private app publishing remains secure, because the developer must have the target organization’s 

Organization ID and an admin must approve any apps targeted to their organization. 

 
 
For more information, please see the ​Help Center. 
 

Manage Android devices without the Google Apps Device Policy app 

  Announced on January 31st, 2018     Admin feature                                                    - ​back to top​ - 

 
What’s new​: Last year, we ​launched​ Basic Mobile Management for iOS—the ability to manage employees’ iOS 
devices, even if those employees don’t set up MDM agents or profiles. We’ve now brought this same feature 
to Android. 
 
Now, G Suite admins can mandate basic security measures on the Android devices their employees bring to 
work, without requiring those employees to install the ​Google Apps Device Policy app​ on their devices. To do 
so, admins simply need to select “Basic” under Device management > Setup > Mobile Management > Enable 
Mobile Management in the Admin console. 
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https://support.google.com/a/answer/1734200
https://support.google.com/googleplay/work/answer/6145139
https://gsuiteupdates.googleblog.com/2016/12/manage-ios-devices-without-mdm-profiles.html
https://play.google.com/store/apps/details?id=com.google.android.apps.enterprise.dmagent


 
When Basic Mobile Management is enabled, admins can: 

● Enforce a device screen lock.* 
● Wipe a corporate account (but not the entire device). 
● View, search, and manage their device inventory. 

Basic Mobile Management makes life easier for end users as well, because it allows them to access their 
corporate accounts without risking their personal data being wiped. 
 
For more details, check out the ​Help Center​. 
 
*Please note that you can only enforce a screen lock on devices running Android L or earlier if those devices 
have the Google Apps Device Policy app installed.  
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https://support.google.com/a/answer/6328699


 

 

Learn more about G Suite 
Cloud Connect: The official community for G Suite Admins 

   Admin resource                                                                                                                                               - ​back to top​ - 

 

 

Sign in today​:​ ​Cloud Connect is your one stop shop 
for resources to make your work with G Suite easier. 
Sign in today​ to discuss best practices, ask 
questions, and communicate with your peers and 
Googlers. Don’t miss out! Make sure you ​follow our 
Community Manager, Lauren Gallegos​, to get the 
weekly buzz. 

 
What’s new:​ In January, we kicked off our Editorial 
Calendar for Q1. We added new use cases to our 
growing catalog, covering topics like ​5 Steps to 
modernize your enterprise data warehouse with 
Google BigQuery and Informatica​ and the ​Tips for 
increasing the usage of Drive and/or G+ within your 
organisation​. 

Join us in February for more use cases on your favorite Google Cloud products. 
 
 

What’s New for G Suite Admins​ videos 

   Admin resource                                                                                                                                                            - ​back to top​ - 

 

 

What’s new:​ ​The ​What’s New for G Suite Admins​ videos 
provide a recap of all of the features we've released in the 
past month that are relevant to G Suite Admins, so you can 
watch and share them whenever you want. 
 

How it works​: ​Bookmark the​ ​playlist on YouTube​ and check 
back each month for updates.  

 
Thanks for checking out our newsletter!  

We’d really appreciate ​your thoughts​ on how we can make this work best for you. 
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https://connect.googleforwork.com/community/customers/?utm_source=WhatsNewJuly15Recap&utm_medium=referral&utm_campaign=JoinGWC
https://connect.googleforwork.com/people/sso-115902687250173948232
https://connect.googleforwork.com/people/sso-115902687250173948232
https://www.cloudconnect.goog/docs/DOC-21810
https://www.cloudconnect.goog/docs/DOC-21810
https://www.cloudconnect.goog/docs/DOC-21810
https://connect.googleforwork.com/docs/DOC-10457
https://connect.googleforwork.com/docs/DOC-10457
https://connect.googleforwork.com/docs/DOC-10457
http://www.youtube.com/playlist?list=PLU8ezI8GYqs4NSPPqm9hkdWPziVh_O3EC
http://www.youtube.com/playlist?list=PLU8ezI8GYqs4NSPPqm9hkdWPziVh_O3EC
https://docs.google.com/a/google.com/forms/d/19AJmnJuG_JWdOTSf0B_kL1DFemE8bbkJbZ42Iz6uDx0/viewform

